ACCURATE ELECTROMAGNETIC SIMULATION OF NEAR-FIELD PERFORMANCE OF AN X-BAND ARRAY FOR HYPERTHERMIA THERAPY APPLICATIONS

Santosh Babu Modini
B.Tech, J N T University, India, 2007

Sandhya Arikatla
B.Tech, J N T University, India, 2007

PROJECT

Submitted in partial satisfaction of the requirements for the degree of

MASTER OF SCIENCE

in

ELECTRICAL AND ELECTRONIC ENGINEERING

at

CALIFORNIA STATE UNIVERSITY, SACRAMENTO

SUMMER
2010
ACCURATE ELECTROMAGNETIC SIMULATION OF NEAR-FIELD PERFORMANCE OF AN X-BAND ARRAY FOR HYPERTHERMIA THERAPY APPLICATIONS

A Project

by

Santosh Babu Modini

Sandhya Arikatla

Approved by:

___________________________, Committee Chair
Suresh Vadhva, Ph.D.

___________________________, Second Reader
Russell Tatro, M.S.

___________________________
Date
Students:  Santosh Babu Modini  
            Sandhya Arikatla  

I certify that these students have met the requirements for format contained in the University format manual, and that this project is suitable for shelving in the Library and credit is to be awarded for the Project.

___________________, Department Chair                                   _________________
Suresh Vadhva, Ph.D.                                   Date  

Department of Electrical and Electronic Engineering
Abstract

of

ACCURATE ELECTROMAGNETIC SIMULATION OF NEAR-FIELD PERFORMANCE OF AN X-BAND ARRAY FOR HYPERTHERMIA THERAPY APPLICATIONS

by

Santosh Babu Modini
Sandhya Arikatla

This project will focus on the application of an advanced electromagnetic simulation software: 4nec2 for the near-field characterization of a 3-element X-band array of waveguide and horn antennas. Previous modeling efforts have shown a significant difference between simulated and measured data. The key effort in this project will be to minimize the difference between simulated and measured data by use of the 4nec2 software. The simulation will be carried out on both a 3-element array of open-ended waveguides and a 3-element array of circular horn antennas. The main application of these arrays is in microwave hyperthermia treatment of tumors by focused heating.

__________________________, Committee Chair
Suresh Vadhva, Ph.D

__________________________
Date
ACKNOWLEDGEMENT

Man has made language to express his feelings. Yet, we find ourselves short of words when it comes to thanking all those who have rendered necessary help for the completion of this project.

First and foremost we would like to express our gratitude and thanks to our advisor, committee chair and graduate coordinator Dr. Preetham Kumar for his expert guidance and constant support throughout this project. His openness and enthusiasm have taught us correct way of working with new technologies and have improved our knowledge of the subject.

We are extremely thankful to Mr. Russell Tatro our second reader, for reviewing this work and for his valuable suggestions in improving the same. It is our duty to recognize the efforts of Electrical Engineering Department and the management for creating an interactive atmosphere for learning.

We would also like to take this opportunity to thank the considerate faculty and staff of Electrical and Electronics Engineering Department who have been encouraging us throughout our curriculum.

At the end we would like to extend our thanks to our parents for their constant encouragement and to all those who have played a small but important role in this project but could not be individually named here.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgement</td>
</tr>
<tr>
<td>List of Tables</td>
</tr>
<tr>
<td>List of Figures</td>
</tr>
<tr>
<td>Chapter</td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
</tr>
<tr>
<td>2. NUMERICAL ELECTRO MAGNETICS CODE (4NEC2)</td>
</tr>
<tr>
<td>2.1 Introduction to 4NEC2</td>
</tr>
<tr>
<td>2.2 Additional Features of 4NEC2</td>
</tr>
<tr>
<td>2.3 4NEC2 Project Flow</td>
</tr>
<tr>
<td>2.4 Configuration</td>
</tr>
<tr>
<td>2.5 Steps for Drawing a Geometric Model</td>
</tr>
<tr>
<td>3. HYPERTHERMIA TREATMENT AND ITS APPLICATIONS</td>
</tr>
<tr>
<td>3.1 Reasons for Hyperthermia</td>
</tr>
<tr>
<td>3.2 Methodology for Hyperthermia Treatment</td>
</tr>
<tr>
<td>3.3 Types of Hyperthermia</td>
</tr>
<tr>
<td>3.4 Types of Hyperthermia Treatment</td>
</tr>
<tr>
<td>3.5 Side Effects of Hyperthermia</td>
</tr>
<tr>
<td>3.6 Future Scope for Hyperthermia</td>
</tr>
</tbody>
</table>
4. SIMULATION RESULTS FOR X BAND WAVEGUIDE ARRAY AND CIRCULAR HORN ARRAY.. ................................................................. 16

4.1 Simulation results for 3 Element Waveguide Array................................................................. 16

4.2 Simulation results for 3 Element Circular Horn Antenna Array........................................ 34

5. CONCLUSION AND SCOPE FOR FUTURE WORK........................................................... 51

References............................................................................................................................................. 52
LIST OF TABLES

1. Table 4.1  Comparison of Measured and Simulated data of the Waveguide Array…48

2. Table 4.2  Comparison of Measured and Simulated data of the Antenna Array……49
LIST OF FIGURES

1. Figure 2.1 Main Window.................................................................6
2. Figure 2.2 Geometry Edit Window..................................................7
3. Figure 2.3 Geometry Edit Window Showing voltage source at a point........8
4. Figure 2.4 Geometry Edit Window Showing Frequency/Ground selection.....8
5. Figure 2.5 Geometry Edit Window Showing Conductivity and Dielectric constant....9
6. Figure 2.6 To calculate NEC output data............................................9
7. Figure 2.7 Window showing the selection of pattern..............................10
8. Figure 2.8 Window showing far field pattern and its equivalent values..........10
9. Figure 4.1a 4NEC2 3D Schematic when all Waveguide elements are in line....17
10. Figure 4.1b 4NEC2 input .nec file when all Waveguide elements are in line....18
11. Figure 4.1c Electric field intensity when all Waveguide elements are in line...19
12. Figure 4.1d Electric field along a XY plane at the highest field point..........20
13. Figure 4.1e Rectangular plot of Near Field pattern when all waveguide elements are in line.........................................................21
14. Figure 4.1f 4NEC2 Schematic when center Waveguide element is 8.9cm behind the other two elements.................................................................22
15. Figure 4.1g 4NEC2 3D Schematic when center Waveguide element is 8.9cm behind the other two elements.................................................................23
16. Figure 4.1h 4NEC2 input .nec file when center Waveguide element is 8.9cm behind the other two elements.................................................................24
17. Figure 4.1i Electric Field Intensity when center Waveguide element is 8.9cm behind the other two elements.................................................................25
18. Figure 4.1j Electric field along a XY plane at the highest field point.............26
19. Figure 4.1k Rectangular plot of Near field pattern when center Waveguide element is 8.9cm behind the other two elements.................................................................27

20. Figure 4.1l 4NEC2 Schematic when center Waveguide element is 11cm behind the other two elements.................................................................28

21. Figure 4.1m 4NEC2 3D Schematic when center Waveguide element is 11cm behind the other two elements.................................................................29

22. Figure 4.1n 4NEC2 input .nec file when center Waveguide element is 11cm behind the other two elements.................................................................30

23. Figure 4.1o Electric Field Intensity when center Waveguide element is 11cm behind the other two elements.................................................................31

24. Figure 4.1p Electric field along a XY plane at the highest field point........................32

25. Figure 4.1q Rectangular plot of Near field pattern when center Waveguide element is 11cm behind the other two elements.................................................................33

26. Figure 4.2a 4NEC2 Schematic when all horn elements are in line........................34

27. Figure 4.2b 4NEC2 3D Schematic when all horn elements are in line........................35

28. Figure 4.2c 4NEC2 input .nec file when all horn elements are in line........................36

29. Figure 4.2d Electric Field Intensity when all horn elements are in line........................36

30. Figure 4.2e Electric field along a XZ plane at the highest field point........................37

31. Figure 4.2f Rectangular plot of Near field pattern all horn elements are in line...............37

32. Figure 4.2g 4NEC2 Schematic when center element is 6.1cm behind the other two elements..................................................................................................................38

33. Figure 4.2h 4NEC2 3D Schematic when center element is 6.1cm behind the other two elements..................................................................................................................39

34. Figure 4.2i 4NEC2 input .nec file when center element is 6.1cm behind the other two elements..................................................................................................................40

35. Figure 4.2j Near Field pattern when center element is 6.1cm behind the other two elements..................................................................................................................40
36. Figure 4.2k Electric field along a XZ plane at the highest field point.................41

37. Figure 4.2l Rectangular plot of Near field pattern when center element is 6.1 cm
behind the other two elements......................................................................................42

38. Figure 4.2m 4NEC2 Schematic when center element is 11 cm behind the other two
elements..........................................................................................................................43

39. Figure 4.2n 4NEC2 input .nec file when center element is 11 cm behind the other two
elements..........................................................................................................................44

40. Figure 4.2o Near Field pattern when center element is 11 cm behind the other two
elements..........................................................................................................................45

41. Figure 4.2p Electric field along a XZ plane at the highest field point.....................46

42. Figure 4.2q Rectangular plot of Near field pattern when center element is 11 cm
behind the other two elements......................................................................................47
Chapter 1
INTRODUCTION

The term Microwaves refers to the electromagnetic waves with short wavelength. One definition comes from Pozar's text "Microwave Engineering" [1], which states that the term "microwave" refers to alternating current signals with frequencies between 300 MHz (3 x 10^8 Hz) and 300 GHz (3 x 10^{11} Hz). Depending on the type and the field of study, the boundaries between far infrared light, microwaves, and ultra-high-frequency radio waves are fairly arbitrary. Microwave components have a wide variety of applications from communications to imaging, remote sensing and heating methods. Depending on the industrial demands and the increasing need, the application of microwaves has been progressively increasing. One such niche application is the use of microwaves for medical diagnostic and treatment. This area of research has been quietly gathering pace and has been moving slowly but steadily towards solving the growing needs of medical science. [1, 2]

Two important components namely far-field and near-field are associated with the microwave electric field. Firstly, the region far from the antenna is known as far-field, where the energy radiates from the antenna only in radial direction is used in communication systems. Secondly, the region close to antenna is known as reactive near-field, where energy is stored in electrical and magnetic field but is not radiated from them. It has applications primarily targeting the medical imaging & therapy techniques.

Microwave Hyperthermia is a very important near-field component of electromagnetic energy, and the X-band frequency range of 8-12 GHz is found to be very
suitable for heat absorption [2]. Tumors in different parts of the body are treated by means of hyperthermia. The tumor area is heated to therapeutic temperatures of about 42°C, without over-heating the surrounding normal tissues. In order to make sure that the normal tissue surrounding tumor area is not effected by the heat radiation, a narrow intense sharp beam focus is necessary. This is the point where accurate antenna setup and formation of conformal microwave antenna radiation is required. [2, 3]

The aim of this project is the theoretical study of a 3-element array of circular horn antennas, operating in the X-band frequency range of 8-12 GHz. The aim of the array is to obtain a beam focus at a prescribed point in the near field of the array. The array also has the ability to move the focus point along the axial direction of the array by adjusting the position of the central focusing element of the array. The theoretical simulations are done using Numerical electromagnetic code (4Nec2) software.

The report is organized as follows: Chapter 1 is an introduction. Chapter 2 describes the 4Nec2 software. Chapter 3 explains background on clinical hyperthermia. Chapter 4 gives simulation results of the three-element waveguide and antenna array using 4NEC2 software. Chapter 5 gives conclusions from the results obtained and direction for future work, followed with the references.
Chapter 2

NUMERICAL ELECTRO MAGNETICS CODE (4NEC2)

2.1 Introduction to 4Nec2:

The Numerical Electromagnetics code (NEC 2) is a user oriented computer code for the analysis of the electromagnetic response of antennas and other metal structures. The earlier versions of NEC had certain limitations such as unable to model antenna close to the ground. NEC2 came into existence by overcoming this limitation. However, one limitation of NEC2 is its inability to model stepped diameter wire. Because of this limitation a new version of NEC called NEC4 was released which can model stepped diameter wire.

4NEC-2 is a NEC-2, NEC-4 and windows based tool for creating, viewing, optimizing and checking 2D and 3D style antenna geometry structures and generate, display and compare near/far-field radiation patterns for both the starting and experienced antenna modeler [5]. It was designed by Arie Voors. We used 4NEC-2 ver. 5.8.1 which has the following features: [5]

- Graphical 2D and 3D visualization of Far- and Near-field data and Geometry structures.
- Drag and drop style Geometry Editor to assist the starting antenna modeler.
- Capable of running up to 11000 wires and/or segments (limited by the max of 2Gb of windows on-board memory)
- Sophisticated real-time 3D geometry and pattern viewer showing real wire-radius.
- Interactive Smith chart visualization for freq-sweeps.
Geometry builder to create cylinder, patch, plane, box, helix and parabola shaped structures using auto-segmentation and/or equal-area rules.

The user is expected to draw the structure, specify material characteristic for each object and identify ports, sources and special surface characteristics. The system then generates the necessary field solutions. The next section describes the various steps to be followed in order to develop the structure, bring about the solution and analyze the same for any given structure.

2.2 Additional Features of 4NEC2:[5]

- Software based on the mininec code
- Calculates near and far fields
- 3D patterns for both geometry and fields
- Extensive library of antennas
- Built in optimizer
- Compare patterns

As mentioned above, 4NEC2 software has some extensive features related to an antenna modeling. The extensive library in 4NEC2 has several predefined functions that are available to use in the project. Also 4NEC2 has a built in optimizer which helps you in optimizing your design for the best solution. It can compare different types of patterns that are obtained as a result and decide the best among them.
2.3 4NEC2 Project Flow:

- Configuration
- Drawing
- Source/Load
- Frequency
- Environment
- Solution
- Plot

2.4 Configuration:

To configure 4NEC2 5.8.1 following steps should be followed.

Click 4NEC2 5.8.1 to start the design

Click: File → Open 4nec2 in/output file → filename (Takes you to a folder where there are many built in designs. Open any one of them)

Click: Settings → select NEC editor (new).

Click: A new window will open showing all the coordinates of the geometrical structure which can be edited. If we want to model a new structure from here following steps should be followed:

Click: File → New → Save as → filename

Now, a new design interface has 3 sub-windows: Main window, geometry window and geometry edit window.
2.5 Steps for drawing geometric model:

On Windows machine Open 4NEC2 5.8.1:

The Main window appears as follows

![Figure 2.1: Main window](image)

The next step would be to draw the geometrical structure.

Click Edit → Input (.nec) file. The following window called geometry edit window will open:
The next step is specify the type of source/load whether it is voltage or current and also specify the coordinates of the point where exactly we want to insert the source/load. For example if your source is voltage then following window shows the selection of voltage source:
The next step in the design is to specify the frequency/ground. The following figure shows the selection of the frequency/ground:

Figure 2.4: Geometry edit window showing frequency/ground selection
If you choose real ground then you need to specify the ground type, conductivity and dielectric constant. The following figure shows that:

![Figure 2.5: Geometry edit window showing conductivity and dielectric constant](image)

The next step in the design is to calculate the radiation pattern and other patterns. The following procedure is to be followed:

![Figure 2.6: To calculate the NEC output data](image)
Now if we want to get far field pattern select the far field pattern and click generate as follows:

![Figure 2.7: Window showing selection of pattern](image)

Following results show up:

![Figure 2.8: Window showing far field pattern and its equivalent values](image)
Chapter 3

HYPERTHERMIA TREATMENT AND ITS APPLICATIONS

Hyperthermia is a procedure for treating cancer in which the tissue temperatures in the tumor are raised to the range of 42-45°C. In other words, Hyperthermia is the process of overheating the body. The word is made up of "hyper" (high) and "thermia" from the Greek word "thermes" (heat). [7]

3.1 Reasons for Hyperthermia:

Microwave Hyperthermia was introduced several years ago to treat cancer patients. However, considering different methods of treatment of cancer, microwave hyperthermia is more dominant in therapeutic applications of tissue heating. The main challenge in microwave hyperthermia is to generate a very narrow beam possible to heat only the affected body parts while protecting the surrounding healthy tissues. Additionally, hyperthermia also has no side effect which is an added advantage for opting Microwave Hyperthermia for treatment of cancer.

Hyperthermia is a heat cancer treatment applied locally to tumors. Heat improves blood circulation and makes tumor cells more susceptible to radiation therapy, killing them more efficiently and quickly. Hyperthermia can be compared with an artificial fever that attacks cancer cells. The combination of both, hyperthermia and low dose radiation makes this therapy the most efficient cancer treatment available today. [8]
In local hyperthermia, heat is applied to a small area, such as a tumor, using various techniques that deliver energy to heat the tumor. Different types of energy may be used to apply heat, including microwave, radiofrequency, and ultrasound. [9]

In another approach, called perfusion, the patient's blood is removed, heated, and then pumped into the region that is to be heated internally. Whole-body heating is used to treat metastatic cancer that has spread throughout the body. It can be accomplished using warm-water blankets, hot wax, inductive coils (like those in electric blankets), or thermal chambers (like incubators).[9]

A number of challenges must be overcome before hyperthermia can be considered a standard treatment for cancer. Many clinical trials are being conducted to evaluate the effectiveness of hyperthermia. Some trials continue to research hyperthermia in combination with other therapies for the treatment of different cancers. Other studies focus on improving hyperthermia techniques. [9] Suggests strongly that, when hyperthermia is used in combination with radiation therapy or chemotherapy, an improvement in response rates can be achieved. Hyperthermia can be helpful with palliation(to treat a disease partially but not cure it completely), often dramatically reducing pain.

3.2 Methodology for Hyperthermia Treatment: [9]

Usually, other forms of cancer therapy such as radiation therapy and chemotherapy are used in combination with hyperthermia. Hyperthermia increases the sensitivity of cancer cells towards radiation. It can also harm the cancer cells that are not affected by radiation. When used in combination with radiation therapy, a gap of one
hour is maintained between the administrations of each treatment. The effects of certain anti-cancer drugs are also increased through treatment by hyperthermia.

3.3 Types of Hyperthermia:

There are 3 types of hyperthermia as described below.

Regional Hyperthermia: In this type various approaches are used to heat large areas of tissue, like cavity, organ or limb.

- **Deep tissue**: In this type of approach external applicators are positioned around the body cavity or organ to be treated, and microwave or radiofrequency energy is focused on the area to raise its temperature.
- **Regional perfusion techniques**: Regional perfusion techniques are used for arms and legs, such as melanoma, or cancer in some organs. In this one, patient’s blood is removed, heated, and then refused back into organ. Usually anticancer drugs are given in this treatment.
- **Continuous hyperthermic peritoneal perfusion (CHPP)**: Continuous hyperthermic peritoneal perfusion (CHPP) is a technique used to treat cancers within the peritoneal cavity (the space within the abdomen that contains the intestines, stomach, and liver), including primary peritoneal mesothelioma and stomach cancer. During surgery, heated anticancer drugs flow from a warming device through the peritoneal cavity. The peritoneal cavity temperature reaches 42-45°C.

**Local hyperthermia**: In this type, heat is applied to a small area, such as a tumor, using various techniques that deliver energy to heat the tumor. Different types of energy may
be used to apply heat, including microwave, radiofrequency, and ultrasound. There are several approaches to local hyperthermia, depending on the location of tumor. [9]

**3.4 Types of Hyperthermia Treatments:**

External techniques are for tumors which are just below the skin. In this one, external applicators are positioned around or near the appropriate region, and energy is focused on the tumor to raise its temperature.

- Intraluminal methods are used to treat tumors within or near body cavities, such as the esophagus. Probes are placed inside the cavity and inserted into the tumor to deliver energy and heat that area directly.
- Interstitial techniques are used to treat tumors deep within the body, such as brain tumors. This technique allows the tumor to be heated to higher temperatures than external techniques. Under anesthesia, probes or needles are inserted into the tumor. Imaging techniques, such as ultrasound, may be used to make sure the probe is properly positioned within the tumor. The heat source is then inserted into the probe. Radiofrequency ablation is a type of interstitial hyperthermia that uses radio waves to kill cancer cells.

**Whole-body hyperthermia:** In this type of hyperthermia cancer that has spread throughout the body has been treated. This can be done with techniques that increase the body temperature to 107–108°F, including the use of thermal chambers or hot water blankets. [9]
3.5 Side effects of Hyperthermia:

Most normal tissues are not damaged during hyperthermia if the temperature remains under 111°F. However, due to regional differences in tissue characteristics, higher temperatures may occur in various spots. This can result in burns, or pain. Perfusion techniques can cause tissue swelling, blood clots, bleeding, and other damage to the normal tissues in the perfuse area; however, most of these side effects are for short period. Whole-body hyperthermia can cause more serious side effects.

3.6 Future scope for Hyperthermia:

To be considered for standard treatment, Hyperthermia had few challenges to overcome. Many clinical trials are being conducted to evaluate the effectiveness of hyperthermia. Some trials continue to research hyperthermia in combination with other therapies for the treatment of different cancers. Other studies focus on improving hyperthermia techniques.
Chapter 4

SIMULATION RESULTS FOR X BAND WAVEGUIDE ARRAY AND CIRCULAR HORN ARRAY

The measured results of the 3 element X-band linear waveguide array and 3-element circular horn antenna array are compared with the simulation results. The simulation studies were done using the 4NEC2 software. This was the first project completed in our laboratory using the new software.

4.1 Simulation results for 3 Element Waveguide:

The simulation parameters are as follows:

Source/Load: voltage source (1+j0) V

Frequency of simulation: 10 GHz

Environment: Free space

The schematic, the near field pattern and the resultant electric field generated using 4NEC2 software is discussed here. The relevant figures of the same are also shown below. As mentioned earlier we consider three cases of the waveguide array, one with all elements in line and the other two configurations are obtained by positioning the center element backward.
Case 1: In this case all the waveguide elements are in line

The above figure shows the 3D view of the waveguide array when all the elements are in line. The Input .nec file showing the dimensions of the geometrical structure is shown below.
Figure 4.1b  4NEC2 input .nec file when all waveguide elements are in line

The simulated results of the above geometrical structure using 4NEC2 are shown below. The simulation results include the resultant electric field. The maximum electric field obtained was 31583 V/m at a distance of approximately 0.1m from origin.
In the above figure the highest electric filed point is noted and a plot of the electric field in the XY plane is generated using 4NEC2. The maximum electric field was 31583 V/m and the minimum was 2.8 V/m. The following figure shows the 2D view of the plot.
A rectangular plot of the simulated results obtained using 4NEC2 is generated. The following figure shows the rectangular plot. From the figure it can be observed that the highest electric filed is obtained at a point 0.01 m from the origin.
Figure 4.1e  Rectangular plot of near field pattern when all waveguide elements are in line
**Case 2: Center array element is 8.9 cm behind the other two elements**

In this section the center element of the array is moved backward by 8.9 cm and electric field intensity of the resultant configuration is shown below. The following figure indicates the geometrical structure of the above discussed configuration.

![Figure 4.1f](image)

Figure 4.1f 4NEC2 schematic when the center waveguide element is 8.9cm behind the other two elements
The 3D view of the above geometrical structure can be seen below.

Figure 4.1g  4NEC2 3D schematic when the center waveguide element is 8.9cm behind the other two elements

The input .nec file which shows the dimensions of the above generated geometrical structure is shown below. Any changes in the geometrical structure can be done by editing the dimensions in this window.
Figure 4.1h  4NEC2 input .nec file when the center waveguide element is 8.9cm behind the other two elements

The simulated results of the above geometry can be seen in the following figure. From the simulated results the highest electric field point is noted and plot of the electric field at this point in XY plane is generated using 4NEC2.
From the above figure the highest electric field was observed to as 652 V/m at a distance of approximately 0.14 m from the origin. At this highest electric field point a plot of the electric field in the XY plane is plotted. The following figure shows the 2D view of the electric field.
From the above figure it can be observed that the maximum electric field intensity is 652 V/m at a distance of 0.14 m from the origin and minimum electric field intensity is 63.3 V/m. A rectangular plot of the above figures can be seen below.
Figure 4.1k  Rectangular plot of near field pattern when center waveguide elements 8.9cm behind other two elements
Case 3: Center array element is 11 cm behind the other two elements

In this section the center element of the waveguide array is 11 cm behind the other two elements. The geometrical structure of the resultant configuration is shown below.

Figure 4.11  4NEC2 schematic when the center waveguide element is 11cm behind the other two elements

The 3D view of the above geometrical structure is shown on the next page:
Figure 4.1m  4NEC2 3D schematic when the center waveguide element is 11cm behind the other two elements

The Input .nec file of the above geometry showing the dimensions of the structure can be seen below.
Figure 4.1n 4NEC2 input .nec file when the center waveguide element is 11cm behind the other two elements

The simulated results of the above geometry can be seen in the following figure. From the simulated results the highest electric field point is noted and plot of the electric field at this point in XY plane is generated using 4NEC2.
From the above figure the highest electric field was observed to as 829 V/m at a distance of approximately 0.14 m from the origin. At this highest electric field point a plot of the electric field in the XY plane is plotted. The following figure shows the 2D view of the electric field.

Figure 4.1o Electric field intensity when the center waveguide element is 11cm behind the other two elements
Figure 4.1p Electric field along a XY plane at the highest field point

From the above figure it can be observed that the maximum electric field intensity is 631V/m at a distance of 0.14m from the origin and minimum electric field intensity is 8.83 V/m. A rectangular plot of the above figure can be seen below:
Figure 4.1q  Rectangular plot of near field pattern when center waveguide elements 11 cm behind other two elements
4.2 Simulation results for 3 Element Circular Horn Antenna array:

The simulation parameters are as follows:

Source/Load: voltage source (1+j0) V

Frequency of simulation: 10 GHz

Environment: Free space

The schematic, the near field pattern and the electric field distribution as seen in the 4NEC2 environment is shown below in the following figures. Three cases obtained by varying the position of the center element are considered for simulation. Simulation results indicate multiple peaks and changes in the electric field peak positions are observed.

**Case 1: In the following three figures, the three array elements are in line**

![4NEC2 schematic when all horn elements are in line](image)
Figure 4.2b  4NEC2 3D schematic when all horn elements are in line

The above figures indicate the geometrical structure of the antenna array when all the elements are in line. It also shows the 3D view of the same. The Input .nec file showing the dimensions of the geometrical structure, the resultant electric field in V/m is shown below. Also the highest electric field point was noted in this figure and a plot of the electric field at this point in the XZ plane is shown below. The peak was found to be at a distance of approximately 0.03 m from the open end of the horn antenna. So a plot of the electric field intensity at this point was generated using 4NEC2. The maximum electric field intensity is 3927V/m and the minimum electric field intensity is 99 V/m was obtained. The graphical representation is also shown on next page.
Figure 4.2c  4NEC2 input .nec file when all horn elements are in line

Figure 4.2d  Electric field intensity when all horn antennas are in line
Figure 4.2e  Electric field along a XZ plane at the highest field point

Figure 4.2f  Rectangular plot of near field pattern all horn antennas are in line
The above figure is a rectangular plot of the near field measured along Y-axis. The maximum electric field is 3927 V/m at a distance of 0.03 m from the origin. It can be noted that the peak value is obtained 0.03 m.

**Case 2: Center array element is 6.1 cm behind the other two elements**

Figure 4.2g 4NEC2 schematic when the center element is 6.1 cm behind other two elements

The above figure indicates the geometrical structure of the antenna array when the center array element is 6.1 cm behind the other two elements. The 3D view of the above figure can be seen below.
Figure 4.2h 4NEC2 3D schematic when the center element is 6.1 cm behind other two elements

The Input .nec file showing the dimensions of the geometrical structure, the resultant electric field in V/m is shown below. Also the highest electric field point was noted in this figure and a plot of the electric field at this point in the XZ plane is shown below. The peak was found to be at a distance of approximately 0.03 m from the open end of the horn antenna. So a plot of the electric field intensity at this point was generated using 4NEC2. The maximum electric field intensity is 3927V/m and the minimum electric field intensity is 99 V/m was obtained. The graphical representation is also shown on next page.
Figure 4.2i 4NEC2 Input .nec file when center element is 6.1 cm behind the other two elements.

Figure 4.2j Near field pattern when center element is 6.1 cm behind the other two elements.
The highest electric field point was noted in the previous figure and a plot of the electric field at this point in XY plane is shown below. The peak was found to be at a distance of approximately 0.04 m from the open end of the horn antenna. So a plot of the electric field intensity at this point was generated using 4NEC2. The maximum field is 3753 V/m and the minimum field is 78.8 V/m.

Figure 4.2k Electric field along a XZ plane at the highest field point
Figure 4.21 Rectangular plot of Near field pattern when center element is 6.1 cm behind the other two elements.

The above figure is a rectangular plot of the near field measured along Y-axis. The maximum electric field is 3753 V/m at a distance of 0.04 m from the open end of the antenna array. It can be noted that the peak has moved toward origin when compared with the Figure 4.1c. This shows that the peak moves toward backward as the center horn antenna is moved backward.
Case 3: Center array element 11cm behind the other two elements

Figure 4.2m 4NEC2 schematic when the center element is 11 cm behind other two elements

The above figure indicates the geometrical structure of the antenna array when the center array element is 11cm behind the other two elements. The Input .nec file showing the dimensions of the geometrical structure can be seen below.
Figure 4.2n  4NEC2 input .nec file when the center element is 11 cm behind other two elements

The resultant electric field in V/m is shown below. Also the highest electric field point was noted in this figure and a plot of the electric field at this point in the XZ plane is shown below. The peak was found to be at a distance of approximately 0.03 m from the open end of the horn antenna. So a plot of the electric field intensity at this point was generated using 4NEC2. The maximum electric field intensity is 4224 V/m and the minimum electric field intensity is 99 V/m was obtained. The graphical representation is also shown on next page.
Figure 4.2o  Near field pattern when center element is 11 cm behind the other two elements.

The highest electric field point was noted in the previous figure and a plot of the electric field at this point in XY plane is shown below. The peak was found to be at a distance of approximately 0.09 m from the open end of the horn antenna. So a plot of the electric field intensity at this point was generated using 4NEC2. The maximum field is 4224 V/m and the minimum field is 99 V/m.
The rectangular plot of the near field measured along Y-axis is shown below. The maximum electric field is 4224 V/m at a distance of 0.09 m from the open end of the antenna array. It can be noted that the peak has moved toward origin when compared with the Figure 4.2c. This shows that the peak moves toward backward as the center horn antenna is moved backward.
Figure 4.2q Rectangular plot of Near field pattern when center element is 11 cm behind the other two elements.
**Comparison of measured and simulated array performance**

The compared results of the 4NEC2 simulation with the measured data obtained previously for the earlier work [10] is shown below. The tables compare the peak values of the beam obtained during measurement and simulation for all three configurations of the waveguide array and circular horn antenna array. Table 4.1 shows the comparison of the waveguide arrays.

<table>
<thead>
<tr>
<th>Array Configuration</th>
<th>4NEC2 Simulation Peak Value (cm)</th>
<th>Measured Peak value (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All waveguide elements in line</td>
<td>1</td>
<td>0.5</td>
</tr>
<tr>
<td>Central waveguide element 8.9 cm behind outer elements</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Central waveguide element 11 cm behind outer elements</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

*Table 4.1  Comparison of Measured and Simulated data of the waveguide array*
When the waveguide elements are in line, the difference between the measured and the simulated value is 0.5 cm which is a small value. When the center waveguide element is 8.9 cm behind, the difference between the simulated and the measured value is 0 cm which is good. When the center waveguide element is moved 11 cm behind the other two elements, both in the simulated and measured results, the peak field moves far from the antenna. The difference between measured and simulated result is 0 cm.

Table 4.2 shows the comparison of the circular horn antenna arrays

<table>
<thead>
<tr>
<th>Array Configuration</th>
<th>4NEC2 Simulation Peak Value (cm)</th>
<th>Measured Peak value (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All antenna elements in line</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>Central antenna element 6.1 cm behind outer elements</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>Central antenna element 11 cm behind outer elements</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

Table 4.2 Comparison of Measured and Simulated data of the antenna array

There is a small difference between the simulated results and the measured data. When the antenna elements are in line, the difference between the measured and the simulated value is 2 cm. When the center element is 6.1 cm behind, the difference between
simulated and the measured results is 3 cms. When the center element is moved 11 cm behind the other two elements, in the simulated result, the peak field moves closer to the antenna whereas the peak field moves further away from the antenna in the measured result. But still there is a difference of 1 cm between the measured and simulated result. It is also noted that there were three peaks; one at the line at which the outer elements are placed (0 cm) and the other peaks are at 2 cm, 5 cm for the measured result.

One of the causes for these differences is due to presence of other lab equipments while measuring data and due to human interference - the person’s proximity to the transmitting and receiving antennas. Another cause for the difference would be due to the fact that 4NEC2 computes the results in an adaptive fashion - runs multiple times to find the accurate solution and it is possible that the number of adaptive solutions chosen to compute these results is not sufficient. Yet another cause would be loose connections between the connectors of the network analyzer while measuring data.
Chapter 5

CONCLUSION AND SCOPE FOR FUTURE WORK

The aim of our project was the accurate simulation of the near-field performance of a 3-element waveguide array and circular horn antenna array operating in the X-band frequency range of 10 GHz. This frequency has applications mainly in medical field such as microwave hyperthermia, where focused microwave radiation is used to treat tumors. In an earlier project, the arrays were designed, assembled and its near-field performance was measured on the HP 8720C Network Analyzer in the CSUS Microwave Laboratory. Currently, the simulation effort is to model these arrays and analyze their performance using the 4NEC2 software, to match the earlier measured results.

The simulation results show a slight difference from the measured results but a clear formation of the near field can be seen. Also from the simulation results we can observe that the beam formed can be effectively controlled by adjusting the array elements. The two dimensional view of the same is also seen to analyze the results in depth.

There is scope for significant future work on the project especially the efficiency of the array, with an aim to increase the resolution of the beam so that much clearer focus can be obtained for hyperthermia applications. This would involve trying out different current distributions for the array elements, which can be achieved by the use of attenuators in the feed section of the array. This is essential in hyperthermia systems where power should be predominantly focused on the tumor area with minimum power to the neighboring healthy tissue.
REFERENCES


[3] Numerical Electromagnetics code
http://www.nec2.org/other/nec2prt1.pdf on July 8 2010

http://vss.pl/lf/04.pdf on July 8 2010


[6] NEC2 tutorial, Information retrieved from website


[8] “Valley Center Institute: Information” retrieved from:

[9] “Hyperthermia in Cancer Treatment: Questions and Answers” retrieved from:
http://www.cancer.gov/cancertopics/factsheet/Therapy/hyperthermia, on July11 2010